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Introduction

LayoutKitchen® is an editor for SwitchXS® scan panels, KeyStrokes and Quickclicks 
keyboards and Proloquo® speech panels. SwitchXS users can use LayoutKitchen to 
create their own scan panels (sometimes also referred to as scan keyboards or scan 
arrays) with just those keys, controls and functions they need, thereby greatly enhancing 
the power and versatility of SwitchXS. KeyStrokes 4 and Quickclicks users can use 
LayoutKitchen to design custom keyboards with images, colors and fonts to taste and 
with a variety of keys and functions. Proloquo users can use LayoutKitchen to create 
their own speech panels for easy access of commonly used phrases or, when images are 
used on the buttons, to build communication panels for people who cannot read or write. 
LayoutKitchen requires Mac OS X 10.4 or later.

LayoutKitchen provides many advanced features to create highly customized panels 
with colored background, labels and buttons, with all kinds of images, and with a 
variety of powerful functions. Yet, LayoutKitchen is easy to use. Beginners can start by 
reusing buttons from existing panels and create more complex panels as they become 
comfortable with LayoutKitchen. To accommodate a variety of users, LayoutKitchen 
provides both mouse-based (drag and drop) and keyboard-based interfaces (keyboard 
shortcuts) for many actions and also includes functions making it easier for switch users 
to design their own panels with limited mouse use.

QuickStart

Using LayoutKitchen is actually quite simple. You install it by dragging LayoutKitchen 
from the disk image or CD to your hard disk. You double click the LayoutKitchen 

The Inspector window

A scan panel window

The Image Browser window

The Button Browser window

Figure 1. The LayoutKitchen screen.
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application icon to load LayoutKitchen. Next, you can create a new panel using the New 
command from the File menu or you can modify an existing panel by pulling down the 
XS Panels, KS Panels or PL Panels menus to select, respectively, an existing SwitchXS 
scan panel, an existing KeyStrokes or Quickclicks keyboard or Proloquo speech panel 
to use as a starting point. Menu commands are available to organize and arrange 
buttons and an Inspector window provides direct access to the properties of the selected 
button(s). Saving the panel to the default location ensures that it will immediately be 
available for use in SwitchXS, KeyStrokes or Proloquo.

Main features

• Layout editor for SwitchXS, KeyStrokes, Quickclicks and Proloquo.

• Supports coloring of panel background, button labels and buttons.

• Supports full-color images of any size on buttons in many graphic formats 
(including PNG, TIFF, JPEG, PSD, PDF).

• Adjustable text font, size and style per button.

• Provides drag and drop editing of buttons, colors and images.

• Includes advanced functions to organize and arrange buttons.

• Allows a wide range of functions to be assigned to buttons, from speech to text to 
AppleScripts and keyboard macros.

• Includes quick-access image and button browsers.

System requirements

LayoutKitchen 2.1 is a Universal Binary that runs on Mac OS X 10.4 and higher. 
LayoutKitchen requires a minimal screen resolution of 800 x 600 pixels. For optimum 
performance and access to all features Mac OS X 10.5 or higher is recommended.
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Installation

LayoutKitchen is distributed on a Disk Image (a file with the extension .dmg) or a CD-
ROM. LayoutKitchen can be installed by mounting the disk image or CD-ROM and 
dragging the LayoutKitchen Application to your hard disk.

It is recommended that you install LayoutKitchen in the Applications folder. 

Activating download copies

In case you have downloaded LayoutKitchen from the Internet, the software will run 
in a full trial mode. Full trial mode expires after 15 days of use (these need not be 
consecutive). At that time LayoutKitchen will revert to restricted trial mode in which 
you will no longer be able to save panels, preferences settings will no longer be saved, 
and the software will refuse to run for more than 30 minutes at a time. You will need 
to activate LayoutKitchen to lift these restrictions. If, after your 15-day full trial has 
expired, you still feel that you require more time to evaluate LayoutKitchen, you can 
send an e-mail to layoutkitchen.trial@assistiveware.com to get an activation code that 
will allow you to extend your trial period for at least 7 consecutive days (counted from 
the moment your extended trial request is received). To lift all restrictions you should 
purchase a license of LayoutKitchen to obtain a permanent activation code. SwitchXS 
and KeyStrokes 4 users do not need to purchase LayoutKitchen and can use their 
SwitchXS or KeyStrokes 4 activation code to activate LayoutKitchen. KeyStrokes 3 
users should upgrade to a KeyStrokes 4 activation code to design their own keyboards 
with LayoutKitchen.

You should enter the activation code as well as your name, company name (if 
applicable), and e-mail address (if applicable) in the Activation window (select 
“Activation...” from the “LayoutKitchen” menu) and press the Add License button (see 
figure 2).

Figure 2. The Activation window
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Proloquo users who want to make speech panels with LayoutKitchen for use in 
Proloquo should also enter the LayoutKitchen activation code in Proloquo. To do this 
launch Proloquo, go to the Proloquo menu, select “Activation...” and enter the activation 
code and other relevant details in the Proloquo Activation window and press the Add 
license button.

Activating CD-ROM copies

In case you obtained LayoutKitchen on a CD-ROM, the application may have been 
pre-registered for you. In this case, when you first launch LayoutKitchen, an Activation 
window (see figure 2) will appear with your permanent activation code already pre-
entered. Now you will only have to enter your name, company name (if applicable), 
and e-mail address (if applicable) in the Activation window and press the Add license 
button. Note that if the Activation window does not appear automatically or a permanent 
activation code does not appear in the designated field, your copy may not have been 
pre-registered and you will have to enter the code you obtained from your reseller 
manually (it may have been written on the disk, the sleeve, a separate piece of paper or 
may have been sent to you by e-mail). In this case, follow the instructions for activating 
download copies.

If you do not activate your copy, LayoutKitchen will run in full trial mode for 15 non-
consecutive days and after that revert to restricted trial mode. To remove all limitations 
you should activate your copy by going to the Activation window (select “Activation...” 
from the “LayoutKitchen” menu) and then follow the above instructions for activating 
download copies.

Please store your permanent activation code and user information in a safe place in case 
you need to re-install the software at some point.

Registration

After activating your copy you are kindly requested to register LayoutKitchen online 
at http://www.assistiveware.com/register.php so that we can keep you informed of 
updates and bug fixes. There are also a number of optional questions on this online form 
that help us to further improve LayoutKitchen. The information supplied will be kept 
confidential.

http://www.assistiveware.com/cgi-bin/jump.cgi?link=http://www.assistiveware.com/register.php&src=XSman
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Getting started: Creating your first panel

There are two easy ways to create a panel. The first one is to start out with an existing 
panel and change and/or remove some of the buttons. The second one is to create a new 
panel and to copy and paste or drag and drop some buttons from an existing panel onto 
that new panel. Below both approaches will be briefly discussed.

Starting from an existing panel

To start with an existing panel you go to either the XS panels, KS panels or PL panels 
menu and select one of the existing panels. Next you can select those buttons you want 
to remove by clicking on the first button and then shift clicking on the subsequent 
buttons until you have them all selected. Once you have them selected you can press 
backspace to delete the buttons or choose Cut or Clear from the Edit menu.

Some buttons you many not want to remove, but instead you want to change them. To 
change a button, select the button by clicking on it. In the Inspector window you can 
examine the button’s current characteristics and change its kind, appearance or content. 
With some trial and error you should be able to change it the way you like. If you 
want the button to mimic some functionality of another existing button, click on that 
other button, examine it in the inspector and then adjust the first button accordingly. 
Alternatively, you can duplicate an existing button (Edit menu) and move the duplicate 
to the new location and make necessary adjustments to its appearance or content.

The Position menu offers all kinds of commands to help you align, spread and size 
buttons in a consistent fashion. If you have positioned the buttons more or less in the 
right locations for row column ordering you can also use the Tidy command from this 
menu to automatically do the finishing touch for you.

SwitchXS scan panels only: If you are creating a scan panel and are done making 
changes to the individual buttons, you need to ensure that the buttons are properly 
grouped for scanning. To this end, the buttons can show a group, a subgroup, and a 
button number (View menu). The group number is shown in the top left of the button, 
the subgroup number in the top right, and the button number in the bottom right (See 
figure 3).

SwitchXS scan panels only - continued: Scanning starts by scanning the groups. When 
a switch is pressed, the scan jumps into the current group to scans the subgroups, a 
second switch press causes the scan to jump into the current subgroup to scan the items 
of that subgroup. So you need to group the buttons in a way that you get the right scan 
order. If you have positioned your buttons in rows (with adjacent buttons touching 
each other) and have left 2 or more pixels between subgroups you can make use of 
LayoutKitchen’s Automatic Grouping command (Organize menu). This command will 
automatically group buttons so that you get row – column style of scanning. Normally, 
it will operate on all buttons, but if you select two or more buttons it will only act on 
the selected buttons. See figure 3 for an example of how you would position buttons to 
allow Automatic grouping to work. For more complicated scan arrangements, please see 
the section “Organizing buttons for scanning”.
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Figure 3. Button organization

Once you are done making changes to the panel you can choose Save As from the 
File menu to save the modified scan panel. If you do this in the default location (the 
SwitchXS Scan Panels folder for scan panels, the Keyboards folder for KeyStrokes 
and Quickclick panels and the Speech Panels folder for speech panels) the panel will 
right away be accessible in SwitchXS or Proloquo. SwitchXS panels will appear 
automatically in the Panels menu of SwitchXS, KeyStrokes panels appear in the 
Keyboard menu of KeyStrokes and Proloquo panels will appear in the Panels menu of 
Proloquo, ready to load and to be used.

Starting from a new panel

The procedure here is much the same like when you start out with an existing panel 
(discussed above) except that now you start by creating a new panel by choosing New 
from the File menu. When you do this, a dialog will come up allowing you to set the 
properties of the new panel. For now you can ignore most settings and only set the panel 
type to either scan panel or speech panel depending on whether you want to create a 
panel for SwitchXS, KeyStrokes and Quickclicks or Proloquo. After clicking OK you 
will get an empty panel window. The next step is to open one of the existing panels 
from the XS panels, KS panels or PL panels menu and select those buttons you would 
like to also use for your new panel. You can use copy and paste or drag and drop to copy 
the selected buttons over to your new panel. From here on you can proceed as discussed 
in the second and subsequent paragraphs of the previous section: changing buttons, 
positioning them, reorganizing them (for scan panels only), and saving.

Group 

Subgroup 

Space between subgroups (≥ 2 pixels) group no. subgroup no. button no. 
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Creating and modifying buttons

Creating new buttons

To create a new button you must have an existing panel open (select one from the XS, 
KS or PL panel menus, or choose Open from the File menu) or have a newly created 
panel open (choose New from the File menu). If you need to make extra space on your 
panel to add new buttons you can resize the panel just like other windows.

There are several ways to create a new button. The two easiest options are to drag a 
button over from the Button Browser (which can be shown or hidden from the Window 
menu) or from an existing panel. The Button Browser is discussed in a later chapter. 
Here we will focus on how a new button or multiple buttons can be created manually.

First, you set the item kind and the button design for your new button in the Inspector 
window. You can also preset a color for the button (depending on the button design the 
color is ignored, used as a fill color or used to colorize the button design) and for the 
button label. Now you choose New Button from the Organize menu or you click the 
New Button button in the Inspector window. This will create a button of the preset kind.

Sometimes you may want to create a whole block of buttons with a fixed size and a 
fixed distance between the buttons. You can do this by selecting New Block of Buttons 
from the Organize menu. A dialog will appear allowing you to specify how many rows 
and columns of buttons you want, what the dimensions of the buttons should be in 
pixels and what the spacing between the buttons should be in pixels. 

Figure 4. Creating multiple buttons at once

Item kinds

There are a number of different item kinds, all of which can be chosen from the Item 
kind popup button in the Inspector window. The table below indicates for each of the 
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item kinds what their function is and whether that item kind can be used for SwitchXS, 
KeyStrokes, Quickclicks and/or Proloquo.

Item kind Purpose SwitchXS KeyStrokes 
and 
Quickclicks

Proloquo

SwitchXS 
Command

Issue one of the commands built into 
SwitchXS.

Yes No No

KeyStrokes 
Command

Issue one of the commands built into 
KeyStrokes.

Yes Yes No

LayoutKitchen 
Command

Issue one of the commands built into 
LayoutKitchen.

Yes Yes No

Proloquo 
Command

Issue one of the commands built into 
Proloquo.

Yes Yes Yes

Mouse Action Move the cursor and click the mouse 
buttons.

Yes No No

Key (to type) Issues a single keystroke. This has the 
same effect as typing a particular key on a 
hardware keyboard.

Yes Yes No

Message (to 
speak)

Speaks a text message. Yes Yes Yes

Load Panel Loads another panel Yes Yes Yes

Text (to type) Types one or more characters Yes Yes Inserts text into 
the Proloquo 
text window

Text Macro Types a series of keystrokes and/or 
characters and can be used to trigger 
keyboard shortcuts (e.g. command-Q to 
Quit)

Yes Yes No

Open Document/
Application

Opens a document or launches an 
application

Yes Yes Yes

Run script Runs an AppleScript Yes Yes No

Configuring buttons

You use the Inspector window to configure each item. First, you select the button to 
configure. The Inspector will then show the properties of the selected button (see figure 
5). At the top of the Inspector window you can see the item kind. A little below that, 
the position and size of the button are displayed. Further down are the settings that 
determine the appearance of the button and finally, at the bottom the content of the 
button can be configured. Item kind was already discussed above and position and size 
are pretty obvious and expressed in pixels so we will skip those here.

The button appearance consists of several aspects. The first one is the button design. 
You can currently choose between the five designs presented in the table below.
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Button Design Properties Colorable

Transparent Button No button is displayed. The text label and image 
are displayed directly on the panel background.

No

Aqua Bevel The standard Mac OS X button. Darkens when the 
button is highlighted or turned on.

No

Plain The button area is “painted” in the selected color 
without any button-like sculpting.

Yes

Simple Bevel A simple bevel type button. Darkens when the 
button is highlighted or turned on.

Yes, button is colorized

Snow Subtly sculpted button. Darkens when the button is 
highlighted or turned on.

Yes, button is colorized

The second aspect of a button’s appearance is what will be displayed. Through a popup 
you can choose between displaying only the image, only the label, or both the label 
and image. The subsequent aspects involve the label color, the button color, and the 

Figure 5. The Inspector window with is various functions

Create a new button 

Select the item kind 

Change position and size 

Select a button design 

Select whether image and/or 
label should be shown 

Set button image 

Optional, add a description 

Set the button label 

Set the cue text 

Item kind specific options in
this case the mouse function

Set button color 
Set label color 

Access detailed appearance 

Set the panel to load

Set the text to speak

Select the sound file to play
(use play button to
sample the audio)
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Figure 6. Shows for all major button types what the inspector looks like and what additional fields, 
buttons and menus are available at the bottom of the content area of the Inspector window
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button image. These can be set by clicking on these items in the Inspector window and 
through the Format menu, both of which will bring up respectively color pickers or a 
dialog to choose an image file. Label and button colors can also be set by dragging a 
color from one of these so-called color swatches onto another color swatch or onto a 
button. Images can also be set by drag and drop of an image file from the Finder on the 
thumbnail or directly onto a button, or by drag and drop of an image from the Image 
Browser (discussed in the “The Image Browser” section). Normally, the same colors 
and image are applied to all four button states. However, if you need more control you 
can click the disclosure triangle on the left (see figure 5). That will give you access to 
label and button colors as well as images individualized for each button state. This is 
further discussed in the section “Advanced button appearance configuration”.

Once you are satisfied with the appearance of your button you can set the button 
contents. There are a number of fields common to all item kinds. The first field is 
optional and allows you to store a description of what the button does. The second 
field contains the label to display on the button. The third common field allows you 
to provide a cue text that is used for voice feedback during scanning. As each button 
is scanned this text is spoken so that a user who cannot read or has low vision knows 
which button is being scanned.

Advanced note: For Run Script buttons the text in the description field is also passed 
on to the AppleScript allowing you to use the description field to pass information to 
your script and let your script use that information to adjust its behavior. For example, 
an AppleScript that starts playing a play list could use this information to determine 
what play list to play, whereby the description field would contain the name of the play 
list to play. This allows you to use the same script for multiple buttons and just change 
the information in the description field to let each button start another play list. Some 
example scripts are included with LayoutKitchen.

What the other, item specific fields and functions are can best be seen in figure 6. For 
the command items (SwitchXS, KeyStrokes, Proloquo and LayoutKitchen commands), 
you can select the command to attach to the button (fig 6a). For the Mouse Actions 
items you select the mouse action (fig 6b).  For the Run Script items you select the 
script to use (fig 6c). The selected script will be stored inside the panel (so that you can 
give the panel to someone else to use without having to supply the script file). If you 
make changes to the script they will not affect your panel until you re-attach the script 
to the button.

For Key (to type) items you select the key to type and you indicate whether you want 
the key to be auto-repeatable (fig 6d). Note that auto-repeatable items only actually 
repeat if auto-repeat is set to On in SwitchXS. For Message (to speak) items you enter 
the text to be spoken (fig 6e). For Load panel items you enter the name of the panel you 
want to be loaded. If you want the default panel to be loaded instead of a specific one 
you need to enter three asterisks (***) as the panel name (fig 6f).

For Text (to type) items you enter the text that should get typed (fig 6g). Just as with 
Key (to type) you can set whether the button should allow key repeat. In Text Macros 
you can combine regular text (as in the Text to type items) with key downs and key 
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ups. For example, to create a button that does command-N (the keyboard equivalent 
for opening a file), you select ‘command’ from the popup and then click the Add key 
button. This will insert a command down and a command up instruction. In between the 
down and up instruction you type the letter N  (fig 6h). Also these buttons can be set to 
allow key repeat or not. For Open Document/Application you select the document or 
application to open (fig 6i).

Additional actions

In addition to the main action, each button can also execute a number of additional 
actions. These are visible in the Additional Actions section of the Inspector (see figure 
5). The Load panel field makes it possible to load a named panel. This can be used to 
create, for example, a button that opens an application and then as an additional action 
also loads a panel specific to that application. Text entered in the Speak text field will be 
spoken as the main action is being executed. This is useful to provide speech feedback, 
for example, to mention what application is being loaded after the button was chosen. 
With Play sound it is possible to select an audio file that will be played when the user 
chooses the button. This can be used to play a stimulating sound if the user selects a 
particular button or to play a prerecorded voice message. The little play button on the 
right side can be pressed to listen to the selected sound.

Changing button label appearance

To set the text font, size and style you need to use the Fonts window (Format menu). 
Any changes you make there apply to all currently selected buttons. Not all features 
of the Fonts Window are currently available in all applications (this is a Mac OS X 
limitation), so changing, for example, the text color in the Fonts Window has no effect 
on the button labels. What you can change there are Font Family, Typeface and Size. 
Those settings can be set per button and will be applied to all button states.

There are various ways to set the label color for the selected buttons:

1) you can use the Label Color command from the Format menu;

2) you can drag a color from the Inspector’s label color color-swatch onto a button;

3) you can double click on the Inspector’s label color color-swatch.

The label color can be set per button. You can even assign a different label color to each 
button state as is explained in the section “Advanced button appearance configuration”.

Changing button colors and images

There are various ways to set the button color for the selected buttons:

1) you can use the Button Color command from the Format menu;

2) you can drag a color from the Inspector’s button color color-swatch onto a button;
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3) you can double click on the Inspector’s button color color-swatch.

The button color can be set per button, but coloring is ignored by the Transparent button 
and Aqua Bevel button designs. How color is applied depends on the button design. 
Plain buttons are painted in the selected color, but Simple Bevel and Snow Key button 
designs are instead colorized (which typically makes the color lighter and softer). The 
section “Advanced button appearance configuration” explains how to set different 
button colors for different button states.

To set a button image you have various options:

1) you can use the Choose Image... command from the Format menu (and the Remove 
Image command from that same menu if you want to get rid of the image again);

2) you can drag an image file from the Finder onto a button;

3) you can drag and image file from the Finder onto the image thumbnail in the 
Inspector;

4) you can double click the image thumbnail;

5) you can drag an image from the Image Browser onto a button;

6) you can double click on an image in the Image Browser. (The Image Browser is 
explained in more detail in the section “The Image Browser”.)

Pick whatever method is most convenient for you.

You can use almost any image file format. PDF vector files are often a good choice 
if you want the image to look good at any scale without getting huge panel files. For 
photo’s JPEG (or JPG) images are often a good choice. If you want images with a 
transparent background the PNG format is recommended. This works well for icon like 
images and object photos. LayoutKitchen further supports all QuickTime convertible 
image file formats.

For all images except the PDF images, LayoutKitchen can limit the dimensions of the 
image that is stored inside the panel. By default, images larger than 128 x 128 pixels 
are scaled down and stored at 128 x 128 pixels instead of full-size. This dramatically 
reduces the size of the panel files, while you as a user do not need to worry about the 
size of the image file you drag onto a button. LayoutKitchen takes care of all that for 
you. However, if you want to make a panel with buttons that are larger than 128 x 128 
pixels you can change the default setting for that panel by choosing Panel Properties... 
from the View menu and clicking on the disclosure triangle to access the advanced 
settings and changing the pixel size limit or even turning it off. This, by the way, is also 
the place where you can set the margin that LayoutKitchen should maintain around your 
images. By default, a 20% margin is kept around the image so that images do not flow 
from edge to edge, covering up the entire button.
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Copying and pasting styles

When you are happy about the design of a particular button you can copy the style and 
paste it onto other buttons. First select the button you want o copy the style from. Next, 
go to the Edit menu and choose Copy Style. Then select the buttons you want to change 
and choose Paste Style from the Edit menu. This will copy the font style, size and color 
as well as the button design and color from the original button to the selected buttons. 

Advanced button appearance configuration

In most cases it is sufficient to assign one label color, one button color and one image to 
each button. However, in some cases you want more flexibility. For example, for a low 
vision user it may be useful if buttons have a different color when they are highlighted 
during scanning (or the mouse is held down on the button). In other cases, a button 
may not only have a normal state but also an on state. This is, for example, the case for 
the auto-repeat toggle button of the Universal scan panel. Normally, a darkening of the 
button indicates the difference. For some users that may not be enough and then it can 
be useful to use different button or label colors or even different images. If you want to 
be able to have this level of control you need to click on the disclosure triangle on the 
left side of the Appearance settings in the Inspector window. When you click it you will 
see something like figure 7. You can set colors and images for up to 4 different Button 
states.

Figure 7. The detailed appearance settings
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Normal The Normal state is the buttons neutral state. It is how buttons will normally appear.

Highlighted When a button is scanned or pressed with the mouse down it will be highlighted, this is the 
Highlighted state.

On When a button can be turned on (after you have selected it by scanning or with the mouse) 
it also has an On state. Typically, the On state is indicated on the Mac by a button that is 
darker than normal, but not as dark as during highlighting. But that darkening may not be 
enough for a visual impaired user.

On & highlighted The On & Highlighted state you get when you scan or click on a button that is On.

In some cases, you will want to just use different colors for Normal versus ON states 
and work with the automatic darkening of the Highlighted and On & Highlighted states. 
In other cases, you may want to set different colors for all 4 states. To simplify drag 
and drop for colors and images and, in the case of images, also to reduce storage you 
can use the little popup menus below the Normal color-swatches and image thumbnail 
to choose between 1, 2, and 4 different colors or images to use for a particular button. 
Selecting 1 means that one color will be used for all states and that any color you 
set will automatically propagate to the other states. Selecting 2 means that you can 
use different colors for Normal and On states and that when you set a color it will 
automatically propagate to the associated highlighted state. Selecting 4 means that you 
can assign a different colors for each state. For images the same rules apply, but while 
allowing multiple states for the colors even if you do not use different colors for each 
state is not a problem, for images it is advisable not to allow for more states than you 
really use for a button, because for each state an image will be stored inside the panel, 
making your panel file larger.

To see how your buttons look in the various button states you can use the View menu to 
change the state in which the buttons are displayed in the editor window. This way you 
can see at once how all your buttons will look when pressed or scanned (Highlighted 
state) or when turned on (On State) or when scanned or pressed while the buttons are 
on (On & Highlighted State). When you have selected a particular state for viewing 
and then drag a color or image onto a button the color or image will be applied to 
that particular state, and of course, where applicable propagating to the other states 
depending on how you setup the little popup menus for that button as discussed in the 
previous paragraph.

If all of this sounds pretty scary and complicated, just click the little disclosure triangle 
on the left side of the Appearance settings of the Inspector Window to hide all these 
details and come back to this section later, whenonce you really need this level of 
control.

Positioning and organizing buttons

Positioning and sizing buttons

There are several ways to position and size your buttons. The most straightforward 
approach is to use drag and drop to position the buttons more or less where you want 
them. Next, you can fine-tune the position using either the arrow keys to pixel by pixel 
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nudge the selected buttons in place or for individual buttons to use the coordinate fields 
of the Inspector Window to change position and size.

LayoutKitchen offers a SmartSnap feature to help you position buttons neatly next 
to each other. To kinds of SmartSnap are available, one for when you drag and 
one for when you nudge the selected buttons with the arrow keys. You can set the 
distances within which snapping takes place in the Preferences, while you can turn 
SmartSnapping on or off through menu items in the Position menu. 

To resize the selected buttons you can use the coordinate fields in the Inspector or drag 
one of the four blue handles at the edges of one of the selected buttons. Note that if you 
find these handles too small or to big you can change their size in the Preferences. You 
can also use the Scale command from the Postion menu, which will not only scale the 
size of the selected buttons, but will also reposition them such that the buttons will not 
start overlapping.

Figure 9. The Scale dialog

Figure 8. The Position menu
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For easier positioning multiple buttons relative to each other you can use the commands 
from the Position menu (see figure 8). If you want to reposition multiple buttons so that 
the amount of space between the buttons becomes equal, you can use the Auto Space 
feature from the Position menu. A dialog will appear allowing you to set the horizontal 
and vertical space between buttons in pixels. For row – column ordered panels you can 
also use the Tidy command, which will try to nudge and stretch those buttons in place 
that are positioned almost right, but not quit perfect yet. It will try to align the tops of 
the rows, make buttons in the same subgroup touch on the left and right edges, and size 
them to match the tallest of the subgroup. This is command is very powerful when used 
correctly, but it will not help you to deal with randomly positioned buttons. It tidies 
buttons that are already almost in place; it does not clean up a total mess. If nothing 
or just one button is selected Tidy applies to the whole panel, otherwise only to the 
selected buttons.

Figure 10. The Auto Space dialog

The Spread Horizontally and Spread Vertically commands spread the selected buttons 
between respectively, the left and right most buttons and the top and bottom most 
buttons. With Spread Horizontally the selected buttons will all get the same width and 
will become top aligned. With Spread Vertically the selected buttons will all get the 
same height and will become left aligned.

The Snap Horizontally and Snap Vertically commands do not spread but snap the 
selected buttons together respectively, stacking them onto the left most button and onto 
the top most button. With Snap Horizontally the selected buttons will not change in size, 
but any space between the buttons will be removed and they will become top aligned. 
Snap Vertically follows the same principle but here the buttons will become left aligned.

The four Align commands do exactly what their names suggest and are applied to the 
current selection.

Height To Least Tall and Height To Tallest give all the selected buttons the same height. 
The first one gives them the height of the least tall button and the second one of the 
tallest button. The Width to Least Wide and Width to Widest follow the same principle 
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but adjust the widths of the selected buttons. These commands can be very useful if you 
have, for example, multiple buttons in a row, but some are a bit differently sized than 
the other buttons and you want to give them all the exact same dimensions.

Once you have moved and resized your buttons you may want to shrink the panel to fit 
snugly around the outermost buttons. Use the Fit Panel to Buttons command from the 
Position menu to let LayoutKitchen automatically resize your panel such that an edge is 
kept around the outermost buttons of exactly as many pixels as you want.

Figure 11. The Fit Panel dialog

Important note: For optimal panel performance it is important, especially for 
SwitchXS scan panels, not to have overlapping buttons. In the Edit menu there is a 
command called “Select Overlapping Items” that can help you locate overlapping items 
so that you can then reposition or resize these items to remove the overlap. When you 
use this command, items that overlap with other items will be selected. To remove the 
overlap for an item you can either change the size and/or position of that item or change 
the size and/or position of the neighboring item that is overlapping with it. After making 
changes you should choose the “Select Overlapping Items” again to see if there are any 
remaining overlapping items that need fixing. Repeat this process until after choosing 
“Select Overlapping Items” a message comes up that there are no overlapping items. 
If you get that message you can be sure your panel has no overlapping items and can 
be drawn with maximum performance. The larger and more complex your panel is the 
more important it is that you make sure there are no overlapping items.

Organizing buttons for scanning

This section is only relevant if you want to design scan panels for SwitchXS, because it 
discusses how to organize your buttons to get the right scanning order. After you have 
done the layout of a new scan panel or made changes to an existing one you need to 
ensure that the buttons are properly grouped for scanning. To this end, the buttons can 
show a group, subgroup, and item number (View menu). The group number is shown 
in the top left of the button, the subgroup number in the top right, and the item number 
in the bottom right (see figure 3). Scanning starts by scanning the groups and when a 
switch is pressed the scan jumps into the current group and scans the subgroups, the 
next switch press causes the scan to jump into the current subgroup and scan the items 
of that subgroup. So you need to group the buttons in such a way that you get the right 
scan order.
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The simplest way to group buttons is to use the Automatic Grouping command from 
the Organize menu. It will automatically group buttons in a way that you get a row 
– column style of scanning. Normally, it will operate on all buttons, but if you select 
two or more buttons it will only act on the selected buttons. See figure 3 for an example 
of how you would position buttons to allow Automatic grouping to work. Automatic 
Grouping does not work right under all conditions. Before using it, you need to position 
your buttons in rows (with adjacent buttons touching each other) and leave 2 or more 
pixels between subgroups. You cannot use automatic Grouping if you organize your 
buttons on column – row order (which is a-typical for scanning anyway), or use some 
sort of free positioning with some parts of the panel in row column ordering and other 
parts in column – row ordering. In the latter case, you may still be able to apply it to the 
row – column ordered part by selecting just those buttons.

If you need more control or want a non-standard scanning order you can use the Group 
and Subgroup commands (Organize menu) to manually group and subgroup the selected 
buttons. In that case, you typically first select all buttons you want to have in a particular 
group and apply the Group command. Next, if a row has many buttons you may want 
to make subgroups for that group.  To do that, you select the subset of buttons that you 
want to have in a subgroup and apply the Subgroup command. You repeat this for each 
subgroup you want to create within the group you made earlier. In this way, you can 
create multiple subgroups for each group. If you notice, by looking at the little numbers 
on the buttons that the groups, subgroups or items are not in the right order you can use 
the Bring Forward and Send Backwards commands to reorder individual buttons within 
their group or subgroup. In a similar way, Bring Subgroup Forward/Send Subgroup 
Backward and Bring Group Forward/Send Group Backward commands can be used to 
reorder respectively subgroups and groups.

When you are done organizing the buttons for scanning you save the panel, go into 
SwitchXS and test the new panel there.

Selecting buttons

For mouse users the easiest way to select buttons is to click them with the mouse and 
change or extend selections respectively using command-click and shift-click, just as in 
most Mac OS X applications. For switch users or people who rely on keyboard access 
using the mouse is not always that easy. The edit menu therefore has a number of extra 
selection features not found in most other applications. There are commands to select 
an entire group or subgroup of buttons (see previous section on grouping), to select the 
next button and to extend the selection one button.
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Panel properties

When you create a new panel using the New command (File menu) a dialog will be 
presented allowing you to set some properties for the newly created scan panel. You 
can change those settings later, if you want, by accessing this dialog through the Panel 
Properties... command in the View menu.

The Panel Properties dialog allows you to set the panel type to either Scan panel for use 
in SwitchXS or Speech panel for use in Proloquo. You can also set the background color 
to use for the panel. Those are the basic settings. To access the more advance settings 
you need to click on the little disclosure triangle next to “Advanced settings”. See figure 
12.

In the advanced settings, you can set the language for the Panel. In most cases you 
should keep this setting to multilingual so that your panel will be available in the panel 
menu of SwitchXS or Proloquo, irrespective of the language in which those applications 
run. However, if you make a panel that is going to be distributed to other people and 
you already know it will only be used by people running SwitchXS or Proloquo in one 
of the specifically listed languages that you can select in the language menu you may set 
it to that particular language. This way the panel will not show up in the list if the user 
runs the application in another language. This prevents such a user from being presented 
with a panel using symbols or key arrangements that have no meaning in that language.

The “Do not show in SwitchXS or Proloquo panel menu” checkbox can be used if you 
do not want a panel to be listed in these menus, for example, if you only want to provide 
access to it by loading it from another panel (through a Load panel button). The “Read-
only” checkbox can be used if you have just made the perfect panel and want to be sure 
that you, or someone else you want to give it to, does not accidentally change the panel. 
A read-only panel can be opened in LayoutKitchen and you can use Save As to save it, 
but you cannot use Save to modify it directly.

Figure 12. The Panel Properties dialog
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The Image margins slider allows you to set the margin LayoutKitchen should keep 
around your images. Set it to 0% if you want your images to go from edge to edge and 
cover the entire button.

The Limit images widths or height checkbox and the associated pixel size setting is 
there to help you keep panel files small, even when a lot of images are used. If you 
never make buttons larger than, say 48 pixels, you can set this value to 48 and then even 
if you drag a 2 MB, page-sized Photoshop file onto an image LayoutKitchen will just 
store a 48 pixel thumbnail of the image in the panel instead of expanding your panel file 
size by 2 MB. If, instead, you want to make a panel with buttons up to 250 pixels, be 
sure to set this setting to 250 pixels to be sure that your image are displayed at optimal 
quality even on your large buttons. Note that this setting is applied to newly created 
buttons (or newly attached images) and does not affect images you already attached to 
buttons. In this way, it is possible to temporarily change the image size for some buttons 
and subsequently, using the Panel Properties dialog again, to create the remainder of the 
buttons with the image size you normally prefer.

The Image Browser

The Image Browser provides convenient quick access to collections of images. Instead 
of having to drag images from the Finder onto your buttons, you can have all the images 
at your fingertips inside LayoutKitchen. You can then either drag images from the image 
browser onto buttons or select a button and double click on an image in the Image 
Browser to apply the image to the selected button. The Image Browser can be accessed 
from the Format menu.

Some image collections are provided with LayoutKitchen, others will be available 
as free downloads from our web site. Yet other collections will be made available for 
sale, such as the Picture Communication Symbols™ (PCS) from Mayer-Johnson that 
contains close to 8000 fully-resizable color images. For purchased image collections 
you will typically have to enter an activation code in the Activation window accessible 
through the LayoutKitchen menu.

You also can easily make your own collections. Just put the images you want to have 
in a collection in a folder. If you want, you can even create subfolders to make a 
hierarchical collection. Then you open the Image Browser in LayoutKitchen (Format 
menu) and choose New collection... from the popup menu at the top of the Image 
Browser window. After you select the folder with your images, you will be presented 
with a dialog that allows you to provide a copyright notice and a URL. The copyright 
will be displayed at the bottom of the Image Browser window when your collection is 
active and if you click on that notice you will be taken to the url.

When making image collections there are three things you should keep in mind. Firstly, 
images are stored in their original size so if you use a lot of very larger images you will 
be creating huge files that are slow to access. It is therefore recommended that you first 
size your images up to the maximum dimension you would want to use on buttons and 
only after that create your image collection. For example, if you have made photos with 
a digital camera and importedant them in iPhoto you would choose the export command 



26

in iPhoto (Sharing menu in iPhoto 5) and then instead of exporting at full-size you 
would click the “scale images no larger than” radio button and enter for example 100 
or 200 for the width. Next in LayoutKitchen you would make your collection from the 
folder of exported images.

Secondly, LayoutKitchen image collections are read-only and cannot be modified. If 
you want to change a collection you need to re-create it from your original folder with 
images. If you give it the same name it will replace the previous one. Also, because the 
collections cannot be modified you need to give your images names in the Finder (or in 
iPhoto) before you create your image collection in LayoutKitchen.

Finally, there are copyrights on many images and photos so while you can in principle 
distribute image collections to other LayoutKitchen users you should ensure that you are 
not breaching the copyrights of the original owners of the images. This does not only 
apply to images that you purchased, but also to images someone you know made and 
gave you. Always ask permission before sharing. If you have made an image collection 
from your own images and wish to share them with all LayoutKitchen users please 
contact us and in most cases we will be happy to discuss with you how it can be made 
available to other users.

The Button Browser

The Button Browser offers quick access to many common button types, such as keys, 
common words, KeyStrokes commands, mouse functions, applications and more. To 
use a button, select the appropriate type from the popup menu in the button browser 
and then scroll until you find the button you want. Next, just drag it into the panel you 
are working on. It will take the size, color and style from the currently selected button, 
making it easy to create a series of buttons in the same style. Just start by selecting 

Figure 13. The Image Browser window
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a button that has the right size and style and then drag in buttons from the Button 
Browser. You can align a new button to existing buttons in your panel by dragging it 
such that you release it when the top and left of the dragged item align correctly with 
the button you want to place it next to.

Note for advanced users: You can also create your own button collections for use 
in the Button Browser. First, create a panel with all the buttons you want to have in 
your button collection. Then choose Save As and look for the Button Collections 
folder (located in ~/Library/Application Support/AssistiveWare Support/, whereby ~ 
is the user home folder). Save the panel into that folder and the Button Browser will 
automatically list the new collection in the popup menu. If you later want to add other 
buttons to the button collection or remove buttons, go to the Open item of the File menu 
and look for the Button Collections folder, open your button collection, make changes 
and choose Save from the File menu.

Figure 14. The Button Browser window
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Preference settings

Accessing the preferences

The LayoutKitchen Preferences can be accessed through the Preferences command from 
the “LayoutKitchen” menu. 

In most cases the default preference settings will be fine but once you gain 
more experience with LayoutKitchen you will appreciate the ability to fine-tune 
LayoutKitchen’ powerful features to your specific needs or preferences.

Show panels for is used to limit the number of panels displayed in the XS Panels, KS 
panels and PL Panels menus to a particular language. Panels can currently be set to 
be multilingual, English, French, or Japanese. You can choose the have panels for all 
languages listed in the menus or just those for a specific language.

Selection handle size is used to set the size of the blue circular handles that are shown 
on select buttons to allow resizing of the buttons. If you have difficulty positioning your 
cursor precisely you can increase the handle size to meet your needs.

SmartSnap within distance is used to set distance within which a button will snap to 
other buttons when moved. Separate values can be chosen for dragging and for nudging 
with the arrow keys.

Create a subgroup if buttons are at least X pixels apart is used by the Automatic 
Grouping feature that helps adjusting the scan order for SwitchXS panels. If the 
horizontal distance between two adjacent buttons is greater than this value,  the 
Automatic Grouping function will create a subgroup.

Figure 15. The LayoutKitchen preferences
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Tips and Tricks

This section describes a few tips and tricks when using LayoutKitchen.

Controlling LayoutKitchen with SwitchXS

Many LayoutKitchen functions can be accessed directly from SwitchXS without using 
the mouse. There is a LayoutKitchen scan panel that provides access to some of the 
most important functions, but there are many more functions that, if you use them 
frequently, you may want to put in a scan panel. Some of these are available through 
a LayoutKitchen command item allowing you to create a button that directly accesses 
these functions; others can be triggered using keyboard shortcuts and can thus be 
defined in the form of a TextMacro button. See the included LayoutKitchen scan panel 
for examples on how such buttons can be constructed.

Keeping the size of panel files limited

If you use a lot of images on your buttons you will see the size of your panel files 
grow rapidly. There are several ways to keep panel size down. The first way is to not 
use bitmapped images but instead use vector images stored in PDF files. You can 
create such images using for example Adobe Illustrator®. Vector files that store the 
coordinates and other characteristics of lines and other objects require much less space 
that bitmapped images that store an image as a collection of pixels. The second way 
is to use the Panel Properties window (accessible through the View menu) and set the 
maximum image size. If a maximum image size is set LayoutKitchen automatically 
shrinks imported bitmap images (such as PNG, TIFF, JPEG files) to this maximum 
size, thereby reducing the size of the panel file. If you change this setting it applies to 
all newly imported images for that panel. Which maximum size is appropriate for you 
depends on the size of the buttons you intend to make. If you make small buttons 32 
or 48 pixels may be more than sufficient, but if you create very large buttons you may 
find that the default 128 pixels may not be enough to get good looking images on your 
buttons.

When to use which image type?

LayoutKitchen can put almost any image type on a button, but some image types are 
more appropriate than others. For photos JPEG images are recommended as these are 
highly compressed and keep the panel file size small. If you want your images to have a 
transparent background so that through the “holes” of the image you still see the button 
you should either use vector PDF files that can retain transparency or create PNG image 
files using an application such as Adobe Photoshop®. Vector PDF files typically take 
up little space (if a PDF image file is large it probably contains one or more bitmapped 
images and is better not used) while PNG files can get quite large.

Using one panel for SwitchXS, KeyStrokes and/or Proloquo

The panel file format for SwitchXS, KeyStrokes and Proloquo is identical so it is easy 
to create a panel once and save it for SwitchXS (in the SwitchXS Scan Panels folder 
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of the AssistiveWare Support folder) or for KeyStrokes (in the Keyboards folder of the 
AssistiveWare Support folder) and for Proloquo (in the Speech Panels folder of the 
AssistiveWare Support folder) from LayoutKitchen. Proloquo will simply ignore those 
buttons it cannot handle such as key and mouse buttons. Similarly, KeyStrokes will 
ignore buttons with mouse functions that make sense for a switch user using SwitchXS, 
but not for a mouse user using KeyStrokes. Designing a panel once and then reusing it is 
useful for communication panels that you want to design only once and then let switch 
users use through SwitchXS and mouse users through Proloquo. It is also practical if 
you want, or example, a keyboard panel to be used by both SwitchXS and KeyStrokes 
users or if you want to migrate a KeyStrokes users with a progressive disability to 
SwitchXS, because the user can continue to use the familiar keyboards, but now access 
them with SwitchXS.

Known issues

Inspector window popup menu visual glitch

In some versions of Mac OS X the popup menus in the Inspector show a strange small 
visual glitch in the top left corner. This does not affect operation in anyway and has 
been fixed by Apple in 10.4 (Tiger)
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Support

Support steps

Step 1. Check this manual and/or consult the LayoutKitchen help function. This 
help function can be accessed through the “Help” menu when Layout-
Kitchen is the active (front-most) application.

Step 2. Consult the dealer where you purchased LayoutKitchen.

Step 3. Contact your local distributor (see below for details).

Step 4. If none of the above help or if you purchased directly with Assistive-
Ware, send an email to LayoutKitchen@assistiveware.com

Local distributors

Please find below a list of the current local distributors. Note that this may change over 
time and that the latest information on local distributors is always available at http://
www.assistiveware.com/resellers.php

Territory Distributor / Dealer Purchase online

North America 
(USA, Canada, 
Mexico & 
Caribbean)

Origin Instruments Corporation 
(full support) 
854 Greenview Drive 
Grand Prairie 
Texas 75050-2438 
USA 
Phone: 972-606-8740 
FAX: 972-606-8741 
Email: support@orin.com 
Web: http://orin.com/access/layoutkitchen/

Origin Instruments Corporation 
(full support) 
http://orin.com/ec/layoutkitchen/

Everywhere else AssistiveWare 
(email only support in English, French or 
Dutch) 
Van Speijkstraat 73-D 
1057 GN Amsterdam 
The Netherlands 
Europe 
FAX: +31-20-6128266 
Email: LayoutKitchen@assistiveware.com 
Web: http://www.assistiveware.com

AssistiveWare 
(email only support in English, 
French or Dutch) 
http://www.assistiveware.com/
purchase.php

mailto:layoutkitchen@assistiveware.com
http://www.assistiveware.com/cgi-bin/jump.cgi?link=http://www.assistiveware.com/resellers.php&src=XSman
http://www.assistiveware.com/cgi-bin/jump.cgi?link=http://www.assistiveware.com/resellers.php&src=XSman
mailto:support@orin.com
http://www.assistiveware.com/cgi-bin/jump.cgi?link=http://orin.com/access/layoutkitchen/&src=XSman
http://www.assistiveware.com/cgi-bin/jump.cgi?link=http://orin.com/ec/layoutkitchen/&src=XSman
mailto:layoutkitchen@assistiveware.com
http://www.assistiveware.com/cgi-bin/jump.cgi?link=http://www.assistiveware.com&src=XS15man
http://www.assistiveware.com/cgi-bin/jump.cgi?link=http://www.assistiveware.com/purchase.php&src=XSman
http://www.assistiveware.com/cgi-bin/jump.cgi?link=http://www.assistiveware.com/purchase.php&src=XSman
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Software License Agreement

AssistiveWare / Niemeijer Consult 
Software License Agreement 
Single Use License

PLEASE READ THIS SOFTWARE LICENSE AGREEMENT (“LICENSE”) CAREFULLY BEFORE USING THE 
SOFTWARE. BY USING THE SOFTWARE YOU ARE AGREEING TO BE BOUND BY THE TERMS OF THIS 
LICENSE. IF YOU DO NOT AGREE TO THE TERMS OF THIS LICENSE (IF APPLICABLE) RETURN THE 
NIEMEIJER CONSULT SOFTWARE TO THE DEALER WHERE YOU OBTAINED IT. DEPENDING ON THE 
TERMS OF DELIVERY OF YOUR DEALER YOU ARE ELIGIBLE FOR A (PARTIAL) REFUND.

1. General. The Software and documentation accompanying this License whether on disk, in read only memory, on 
any other media or in any other form (henceforth referred to collectively as the “Software”) are licensed, not sold, to 
you by Niemeijer Consult for use only under the terms of this License, and Niemeijer Consult reserves all rights not 
expressly granted to you. The rights granted herein are limited to the use rights of the Software and do not include 
any other rights. You own the media on which the Software is recorded but Niemeijer Consult and/or Niemeijer 
Consult’s licensor(s) retain ownership of the Software itself.

2. Evaluation copies. This license also applies in full for so-called demo or evaluation copies of the Software for 
which use is solely permitted for a period of a few days up to (in case explicitly stated) a maximum of 3 weeks before 
purchase. If the Software is not purchased within the stated period the Software should be removed permanently and 
completely from the computer(s) on which it has been installed. 

3. Permitted License Uses and Restrictions. This License allows you to install and use one copy of the Software 
on a single computer at a time. This License does not allow the Software to exist on more than one computer at a 
time except for home use by a single individual. It is not permitted to use the Software on more than one computer 
at a time or make the Software available over a network where it could be used by multiple computers at the same 
time. You may make one copy of the Software in machine-readable form for backup purposes only; provided that 
the backup copy must include all copyright or other proprietary notices contained on the original. Except as and 
only to the extent expressly permitted in this License or by applicable law, you may not copy, decompile, reverse 
engineer, disassemble, modify, or create derivative works of the Software or any part thereof. THE SOFTWARE 
IS NOT INTENDED FOR USE IN THE OPERATION OF NUCLEAR FACILITIES, AIRCRAFT NAVIGATION 
OR COMMUNICATION SYSTEMS, AIR TRAFFIC CONTROL SYSTEMS, LIFE SUPPORT MACHINES OR 
OTHER EQUIPMENT IN (OR, MORE IN GENERAL, CIRCUMSTANCES UNDER) WHICH THE FAILURE 
OF THE SOFTWARE COULD LEAD TO DEATH, PERSONAL INJURY, OR SEVERE PHYSICAL OR 
ENVIRONMENTAL DAMAGE.

4. Transfer. You may not rent, lease, lend or sublicense the Software. You may, however, make a one-time permanent 
transfer of all of your license rights to the Software to another party, provided that: (a) the transfer must include all 
of the Software, including all its component parts, original media, printed materials and this License; (b) you do not 
retain any copies of the Software, full or partial, including copies stored on a computer or other storage device; and 
(c) the party receiving the Software reads and agrees to accept the terms and conditions of this License.

5. Termination. This License is effective until terminated. Your rights under this License will terminate automatically 
without notice from Niemeijer Consult or a Niemeijer Consult authorized representative if you fail to comply with 
any term(s) of this License. Upon the termination of this License, you shall cease all use of the Software and destroy 
all copies, full or partial, of the Software.

6. Limited Warranty on Media. Niemeijer Consult warrants the media on which the Software is recorded and 
delivered by Niemeijer Consult to be free from defects in materials and workmanship under normal use for a period 
of thirty (30) days from the date of original retail purchase. Your exclusive remedy under this Section shall be, at 
Niemeijer Consult’s option, a refund of the purchase price of the Software or replacement of the Software, which 
is returned to Niemeijer Consult or a Niemeijer Consult authorized representative with a copy of the receipt. This 
limited warranty and any implied warranties on the media including, but not limited to, the implied warranties 
of merchantability, of satisfactory quality, and of fitness for a particular purpose, are limited in duration to thirty 
(30) days from the date of original retail purchase. Some jurisdictions do not allow limitations on how long an 
implied warranty lasts, so the above limitation may not apply to you. The limited warranty set forth herein is the 
only warranty made to you and is provided in lieu of any other warranties (if any) created by any documentation or 
packaging. This limited warranty gives you specific legal rights, and you may also have other rights, which vary by 
jurisdiction.
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7. Disclaimer of Warranties. YOU EXPRESSLY ACKNOWLEDGE AND AGREE THAT USE OF THE 
SOFTWARE IS AT YOUR SOLE RISK AND THAT THE ENTIRE RISK AS TO SATISFACTORY QUALITY, 
PERFORMANCE, ACCURACY AND EFFORT IS WITH YOU. Except for the limited warranty on media set 
forth above and to the maximum extent permitted by applicable law, the Software is provided “as is”, with all faults 
and without warranty of any kind, and Niemeijer Consult and Niemeijer Consult’s licensors (collectively referred 
to as “Niemeijer Consult” for the purposes of sections 7 and 8) hereby disclaim all warranties and conditions with 
respect to the Software, either express, implied or statutory, including, but not limited to, the implied warranties 
and/or conditions of merchantability, of satisfactory quality, of fitness for a particular purpose, of accuracy, of quiet 
enjoyment, and non-infringement of third party rights. Niemeijer Consult does not warrant against interference with 
your enjoyment of the Software, that the functions contained in the Software will meet your requirements, that the 
operation of the Software will be uninterrupted or error-free, or that defects in the Software will be corrected. No 
oral or written information or advice given by Niemeijer Consult or a Niemeijer Consult authorized representative 
shall create a warranty. Should the Software prove defective, you assume the entire cost of all necessary servicing, 
repair or correction. Some jurisdictions do not allow the exclusion of implied warranties or limitations on applicable 
statutory rights of a consumer, so the above exclusion and limitations may not apply to you.

8. Limitation of Liability. TO THE EXTENT NOT PROHIBITED BY LAW, IN NO EVENT SHALL NIEMEIJER 
CONSULT BE LIABLE FOR PERSONAL INJURY, OR ANY INCIDENTAL, SPECIAL, INDIRECT OR 
CONSEQUENTIAL DAMAGES WHATSOEVER, INCLUDING, WITHOUT LIMITATION, DAMAGES 
FOR LOSS OF PROFITS, LOSS OF DATA, BUSINESS INTERRUPTION OR ANY OTHER COMMERCIAL 
DAMAGES OR LOSSES, ARISING OUT OF OR RELATED TO YOUR USE OR INABILITY TO USE THE 
SOFTWARE, HOWEVER CAUSED, REGARDLESS OF THE THEORY OF LIABILITY (CONTRACT, TORT 
OR OTHERWISE) AND EVEN IF NIEMEIJER CONSULT HAS BEEN ADVISED OF THE POSSIBILITY OF 
SUCH DAMAGES. Some jurisdictions do not allow the limitation of liability for personal injury, or of incidental or 
consequential damages, so this limitation may not apply to you. In no event shall Niemeijer Consult’s total liability 
to you for all damages (other than as may be required by applicable law in cases involving personal injury) exceed 
the amount of fifty euro (euro 50.00). The foregoing limitations will apply even if the above stated remedy fails of its 
essential purpose.

9. Controlling Law and Severability. This License is established in the Dutch language, which will be regarded as 
the authentic language for this License. Any translation of this License is done for local requirements. In the event 
of a dispute between the Dutch and any non-Dutch versions, the Dutch version of this License shall govern. The 
agreement that will be entered in will be governed exclusively by Dutch law and disputes shall be exclusively brought 
in front of Dutch judges and courts in the Netherlands, unless prevailing International Treaties enforce a different 
regulation. In those cases where the choice of forum (court or judge) is not up to Niemeijer Consult but to the user of 
the Software the user obliges himself/herself to select a Dutch judge in The Netherlands. If for any reason a court of 
competent jurisdiction finds any provision, or portion thereof, to be unenforceable, the remainder of this License shall 
continue in full force and effect.

10. Complete Agreement. This License constitutes the entire agreement between the parties with respect to the use of 
the Software licensed hereunder and supersedes all prior or contemporaneous understandings regarding such subject 
matter. No amendment to or modification of this License will be binding unless in writing and signed by Niemeijer 
Consult or Niemeijer Consult’s authorized representatives.
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